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Chapter 7

Customizing
QuickBooks

Objectives

After completing this chapter, you should be able to:
» Modify QuickBooks Preferences (page 206)
e Customize QuickBooks menus and windows (page 208)
s Customize the Icon Bar and display settings (page 210)
e Use the Item List and other Lists (page 212)
+ Use Custom Fields to track extra data on transactions (page 223)

¢ Create and customize sales forms {page 224)

Restore this File:

This chapter uses the Customizing-12.QBW. To open this file, restore the
Customizing-12.QBM file to your hard disk. See page 8 for instructions on
restoring files. If you are using QuickBooks Premier Accountant, we recommend
that you toggle to QuickBooks Premier General Business as described on page x.

QuickBooks has many customizable options that allow you to configure the program to meet
your own needs and preferences. This chapter introduces you to many of the ways you can
make these configurations in QuickBooks using Preferences, customizing the Home page,
menus, and toolbars, and creating templates for forms. This chapter also introduces some new
lists, including the Ifem List, the Terms List, and the Template List.

QuickBooks Preferences

There are two types of Preferenices in QuickBooks:

1. User Preferences. In QuickBooks, User Preferences are specific to the user who is
currently logged on to the file. You can identify User Preferences on the My Preferences
tab in the Preferences window. A user can make changes to his or her User Preferences
as desired. The changes will not affect other users of the data file. Examples of User
Preferences include changing displays setting (e.g., colors), report settings, and spell
check settings.

2. Company Preferences. Use Company Preferences to make global changes to the
features and functionality of an individual company’s data file. For example, the
Preference that turns Sales Tax Tracking on or off is a Company Preference. Only the
Administrator of the data file can make changes to Company Preferences. Note that
each company’s Preferences are independent of the Preferences established for other
QuickBooks companies on your computer..
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206 Customizing QuickBooks — QuickBooks Preferences

In this section, you will learn about a few of these Preferences and how they affect QuickBooks.
Clicking the Help button in the Preferences window will launch QuickBooks Help with specific
topics relevant to the Preference in the open window,

Note:
Many of the Preferences are discussed in detail in other chapters. For example, the

payroll preferences are discussed in the “Payroll Setup” chapter, beginning on
page 299,

Setting User Preferences

COMPUTER PRACTICE
To access QuickBooks Preferences, follow these steps:
Step 1. Select the Edit menu, and then select Preferences.

User Preferences — Desktop View

Use the Desktop View User Preferences (“My Preferences” tab)to customize the view of the
current user,

Step 2. Click the Desktop View icon. See Figure 7-1,
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Figure 7-1 User Preferences - Desktop View

The user preferences for Desktop View allow you to customize the default windows that show
when you open QuickBooks. We recommend selecting Multiple Windows as shown on Figure
7-1. When you first create a data file, QuickBooks selects One Window as the default
Preference. Unless you change the Preference to Multiple Windows, you will not be able to
display more than one QuickBooks window at a time, and you will not be able to change the
size of QuickBooks windows. You will probably find the program much easier to navigate if
you select Multiple Windows. You can also change the color and graphics of QuickBooks
toolbars and windows by selecting a different default from the Color Scheme drop down menu.
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There is also the Show Home page when opening a company file option. Activating this Preference
causes the new Home page window to be displayed whenever the company file is opened.

Tip:

If you use QuickBooks in a multi-user environment, it may be best to select the
Don’t save the desktop radio button on the window shown in Figure 7-1. If you
save the desktop, each time you open QuickBooks it will re-open all of the
windows and reports you were viewing when you last used the program. If you
save the desktop, this may negatively impact performance for other users when
they open the data file.

Company Preferences — Desktop View

Administrators may use the Company Preferenices tab in the Desktop View Preferences to control
which icons display on the Home page. These settings will affect every user who uses this
company file.

Step 3.

With the Deskiop View Preference still selected, click the Company Preferences tab
(see Figure 7-2).
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Figure 7-2 The Desktop View—Company Preferences window

Step 4. Click the Statements and Statement Charges checkbox to deselect.

In this window, you can remove some icons from displaying on the Home page.
Turning off the icon on the Home page does not disable the feature, since you can
access the command using the appropriate menu. Some features, such as Estimates,
Sales Tax, and Sales Orders listed in the lower portion of the Deskiop View Company
Preference window can only be removed from the Home page by disabling the
feature using the appropriate Preferences. You can access the appropriate Preference
through the links in the Desktop View Company Preferences window.
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Note:
You cannot remove the icons for Invoices, Enter Bills, or Pay Bills from the Home
page if certain other features are enabled. For example, the Invoices icon must be
turned on if your company uses Estimates or Sales Orders. For a complete list of
Preferences, see QuickBooks Help.
Step 5. Click OK to close the Preferences window. Click OK in the dialog box that appears
about closing open windows.
Step 6. Click the Home button on the fcon Bar. Notice that the Statements branch of the
Customers section of the Home page no longer displays (see Figure 7-3),
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Figure 7-3 Home Page without Statements branch displaying

Customizing QuickBooks Menus and Windows

QuickBooks gives you the ability set up some special customized features. You can create a
Favorites Menu for your regular activities. You can also customize the Icon Bar, which gives you
easy access to various commands.

Favorites Menu

The Favorites menu is a customizable menu where you can place your common QuickBooks

commands.
COMPUTER PRACTICE
Step 1. Locate the Favorites menu between the Lists and Company menus on the menu bar.

(Those using QuickBooks Premier Accountant will see it between the Lists and
Accountant menus).

If you do not see the Favorites menu, you can turn it on by selecting Favorites Menu
from the View menu (see Figure 7-4).
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Figure 7-4 Favorites Menu option in the View menu

Step 2. Select the Customize Favorites option from the Favorites menu (see Figure 7-5).
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Figure 7-5 Customize Favorites option in the Favorites menu

Step 3. The Customize Your Menus window includes all available menu items. You can select
a menu item to be easily accessed through the Favorites Menu. Click Sales Rep List
and then click Add (see Figure 7-6).

You can use the Sales Rep List to identify employees who receive commission as a
percentage of sales. This List is usually only availabie through the Customer Vendor
Profile Lists submenu under the Lists menu. By adding it the Favorites menu, it can be
accessed outside a submenu, more easily.
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Figure 7-6 Sales Rep List added to Favorites menu in the Customize Your Menus window

Step 4. Click OK to close the Custornize Your Menus window.
Step 5. Select the Favorites menu and chose Sales Rep List (see Figure 7-7).
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figure 7-7 Sales Rep List in the Favorites menu

Step 6. Close the Sales Rep List.

QuickBooks Icon Bar

The Icon Bar appears at the top of the screen below the menu (see Figure 7-8). The icons on
the Icon Bar are shorteuts to QuickBooks windows. The Icon Bar allows you to create an icon
shortcut to almost any window in QuickBooks. The Icon Bar can be selected or deselected from
the View menu and can be customized.
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bpp(mi:r Smpuhuts Cuttomers Vendors Employess ma«w De:s Reminders Feedbatk | Senices Add Payrol Cards & eChetks Userk

Figure 7-8 lcon Bar

Customizing the Icon Bar

There are two ways to customize the [con Bar: using the Customize Icon Bar window or using
the Add “window-name” to Icon Bar option.

Using the Customize Icon Bar Window

Use the Customize Icon Bar window to add icons to the Icon Bar or to edit or delete existing
icons. You can also use this window to add separators between icons and to reposition icons.

COMPUTER PRACTICE

Step 1. Select Customize Icon Bar from the View menu. QuickBooks displays the Customize
fcon Bar wmdow shown in Figure 7-9.

LToreurdu-mem,dragmMsdammdw
of dorn Ip the position you want.

Iron Bar Display Options
@ Showicons and bext

Search Box Digplay Options
¥] show Search Box in icon Bar
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Figure 7-9 Customize icon Bar window
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Step 2. To add an Icon to the fcon Bar click Add. QuickBocks opens the window shown in
Figure 7-10.
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Fr'gure 7-10 Add fcon Bar Item window

Step 3. Select Calculator from the list of icons as shown in Figure 7-11. Notice that
QuickBooks automatically selects the preferred icon for calculator and recommends
the label name and description.
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Figure 7-11 Add Icon Bor Item window with Calculator selected

Step 4. Click OK to create the Caiculator icon.

Step 5. The order of the icons on this list dictates the order of the icons on the Jcon Bar. To
move the Calcicon, click the diamond next te Calc and then drag and drop Cafc to
move it above the Add Payroll icon as shown in Figure 7-12.

TR s e S T S eT 3

 Customipelcon Bar

[con Bar Content
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on the list, select the
diamond to the left of the
lcon name and use your
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diamond, QuickBooks
shows a double-arrow and

dotted lne to guide you.

Figure 7-12 Use your mouse to move icons up or down in the fist.

Step 6. To remove an icon from the icon Bar, select the icon in the list and click Delete.
Highlight the Feedback item and then click Delete,
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Step 7. You may find it helpful to group the icons by type. To add a separator, select the
Calc icon and then click Add Separator. QuickBooks will insert the word “(space)”
below the Calc icon on the list (see Figure 7-13). On the lcon Bar itself, QuickBooks
will add a vertical line between the Calculator icon and the Payroll icon.

Icon Bar Content
+Online Banking -
+Docs

+Reports

«{space)

+(space)

+Reminders

+(space)
<+ Services
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create a line on the lcon
Bar between lcons.

o {space) L
+Add Payroll
+Cardg 8 eChecks -

T—Toreorderﬂ:eicm,&agmimn’s:immdm
or, sition you want,

Figure 7-13 lcon List with Separator

Step 8. To accommodate additional icons, or to reduce the height of your Icon Bar, you can
select Show icons only in the Display Options section shown in Figure 7-13. For now,
leave the Show icons and text option selected.

Step 9. Click OK to save your changes. Figure 7-14 displays the customized icon Bar.

& 4 = &

“ Reminders | Services Calc | AddPayroll Cards

figure 7-14 Customized Icon Bar

QuickBooks ltems and Other Lists

To help you track more details about your sales, QuickBooks provides several Lists that allow
you to add more information to each transaction. In this section, you will learn how to create
items in the Item List, Terms List, Price Level List, and Templates List. You will also learn how
Custom Fields can be used to add more detail to several of your Lists and Reports in
QuickBooks.

QuickBooks Items

The Item List is used to identify the products and services your business purchases and/or sells.
Items in the Item List are also used as part of the sales tax tracking process as a means of
generating subtotals and as a method of calculating discounts. In this section, you will learn
more about QuickBooks Ifems and how they affect the “accounting behind the scenes” as you
create transactions.

The Item List shows all Items you have already created (see Figure 7-15).
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Figure 7-15 The Item list

item Types

There are several different types of Iterns in QuickBooks (see Figure 7-16). When you create an
Item, you indicate the Item Type along with the name of the Itermn and the Account with which
the Item is associated.
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Figure 7-16 The Type menu in the New item window

o Service Items: Used to track services you buy and/or sell.
o Inventory Part Items: Used to track your purchases and sales of inventory.

e [Inventory Assembly Items: Used to track Items that contain assemblies of other Items. You
must have QuickBooks Premier or QuickBooks Enterprise Solutions to use Inventory

Assembly Items.

¢  Non-inventory Part Items: Used to track products you buy and/or sell but don’t keep in
inventory.

e Other Charge Items: Used to track miscellaneous charges such as shipping and finance
charges.

o Subtotal Items: Used to calculate and display subtotals on sales forms.

o Group Items: Allows you to use one Ifem to “bundle” several Items together. Group Items
are similar to Inventory Assembly Items, but Group items do not track quantity on hand
(or sold) of the Group. Rather, each Itern within the Group is tracked separately.

o Discount Items: Used to calculate and display discounts on sales forms.

o Payment Items: Used to show payments collected on the face of Invoices and refunds
given on the face of Credit Memos.

Customizing QuickBooks — QuickBooks Items and Other Lists




214 Customizing QuickBooks — QuickBooks items and Other Lists

» Sales Tax Item: Used to track sales taxes in each location where you sell taxable goods
and services.

» Sales Tax Group Items: Used when you pay sales tax to more than one tax agency. The
Sales Tax Group Item allows you to group several Sales Tax Items together into one total.
The total tax from each Sales Tax Item in the group is the amount of tax charged when
you use the group on sales forms, but QuickBooks tracks each Sales Tax Item in the
group separately. In most states, you don’t need to use Sales Tax Groups. Use Sales Tax
Group Items only if you pay sales tax to more than one agency.

Service Items

Academy Photography sells photo sessions by the hour. To track the sales of a Service Item,
create an Iftern called Photo Session, and associate the Item with the Services income account,

COMPUTER PRACTICE

Step 1. Select the Lists menu and then select Item List.

Step 2. Select the Item button and then select New.

Step 3. Select Service from the Type drop-down list as shown in Figure 7-16 if it is not
already selected, and fill in the detail of the /tem as shown in Figure 7-17.

Step 4. Click OK to save the {tem.
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Desaiption

Photo Session Service

Figure 7-17 Selecting itemns

If the price for this service fluctuates, you can override this amount when you use it on a sales
form. Therefore, when you set up the Itemn, enter the rate you normally charge.

Subcontracted Services

To track your subcontracted services, you can set up a special “two-sided” Service Item to track
both the income and the expense of the subcontractor. By using a single Item to track both
the income and expense for the subcontracted service, you can automatically track the
profitability of your subcontractors. You might want to have a separate Ifem for each
subcontractor.

COMPUTER PRACTICE
Step 1. With the ftem List displayed, press Ctrl+N. This is another way to set up a new /tem.
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Step 2. Select Service from the Type drop-down list if it is not already selected and press
Tab.

Step 3. Enter Video Photographer in the ftem Name/Number field and check the Subitem of
box.

Step 4. Select Photographer from the Subitem of drop-down list.

Step 5. Check the box next to This service is used in assemblies or is performed by a

subcontractor or partner.
Selecting this box allows you to use the same /tem on purchase transactions and
sales transactions, but have the /tem affect different accounts depending on the

transaction,

Step 6. Enter the Description on Purchase Transactions, Cost (purchase price), Expense Account,
and Preferred Vendor for this Item as shown in Figure 7-18.

Step 7. Select Non in the Tax Code field.

Step 8. Enter the Description on Sales Transactions, Sales Price, and Income Account for this

Item as shown in Figure 7-18,

Step 9. Click Next to save the /tem and open another New ftem window.
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.. Subcontracted Video Photographer - Subcontracted Video Photographer

ot | el s [

- Expense Account {53500 - Subcontract... v | - Tax Code [von v

Prefesred Vendor [Wong & SonVideo v | Income Account  [40000 -Services i ]

Figure 7-18 § ubcontracted Service Item
Non-Inventory Parts
To track products that you buy and/or sell but don't monitor as inventory, set up Non-

Inventory Part Items. Academy Photography doesn’t track custom photo packages in inventory,
so they use one generic Ifern called Custom Photo Package.

COMPUTER PRACTICE

Step 1. Select Non-inventory Part from the Type drop-down list,
Step 2. Enter Custom Photo Package in the ltem Name/Number field.
Step 3. Fill in the detail of the /tem as shown in Figure 7-19.

Step 4. Click Next to save the item.
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T b

i‘ Newhem

Type

; . ¢ Use for goods you buy but don't track, like office

\Nondnventory Part v . supplies, or materials for a spedfic job that you
charge back to the customer.

Ttem NameMNumber [ ] Subitem of ~ Manufacturer's Part Number
Custom Photo Pa... S ]
‘ \ Unit of Measure
| Enable...
— | Item is inactive
This item is used in assemblies or is purchased for a specific customerjob
Description Price N 000}
Custom Phato Package

TagCodei]’ax ' v“

Account | 45000 - Sdles v |

Figure 7-19 Non-inventory Part ltem
Non-Inventory Parts - Passed Through

You can also specifically track the income and expenses for each Non-Inventory Part. In this
case, you should create a “two-sided” Non-inventory Part Item to track the purchase costs in a
Cost of Goods Sold (or Expense)} account, and the sales amounts in an income account. This is
particularly useful when you pass the costs on to your customers for special-ordered parts. For
example, Academy Photography tracks camcorder orders with one Non-Inventory Part Item.
COMPUTER PRACTICE

Step 1. If necessary, select Non-inventory Part from the Type drop-down list. Fill in the
detail of the /tem as shown in Figure 7-20,

Step 2. Click Next to save the item.
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Preferred Vendor Acesupply _ v Income Account ‘15000 ‘Sales v

figure 7-20 Non-inventory Part Item - passed through
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Other Charge Items

To track charges like freight, finance charges, or expense reimbursements on your Invoices, use
Other Charge Items.

COMPUTER PRACTICE

Step 1. Select Other Charge from the Type drop-down list and fill in the detail of the ftem as
shown in Figure 7-21.

Step 2. Click Next to save the Item.

Type
{Other Charge

- | Use for miscelaneous labor, material, or part
-T.1 charges, such as defivery charges, setup fees,
and service charges.

Ttem Name/Number  [T] Subitem of
lspping 1 [ ]

[F"] This item is used in assemblies or is a reimbursable charge

Description Amountor % Tax Code
Shipping and handling L_ 8'95]1 Non v 1 Item is inactive
. Account

40000 - Services v |

Figure 7-21 Track shipping charges with an Other Charge'!tem
Sales Tax Items

The Sales Tax Items are used to track sales tax.

CONMPUTER PRACTICE
Step 1. Select Sales Tax Item from the Type drop-down list and fill in the detail of the /tem
as shown in Figure 7-22.
O 4 PR e i e R
Type
oo T | g to calculate a single sales tax at a spedfic rate
[Sa!ﬁs Tax Item -7 I that you pay to a single tax agency.
Sales TaxName
santacriz |
Make sure you enter the name of your tax
Description collector In the Tax Agency field. QuickBooks

"Il needs this name for sales tax reports and

{Santa Cruz S-é1és:'.Tax S
Tax Rate {%) it you collect fo
| 9.0%) |State Board of Equalization _

Figure 7-22 Track sales tax with the Sales Tax Item,

Step 2. Click OK to save this ltem and close the New Items window.

You should create a separate Sales Tax Item for each tax imposed by each taxing jurisdiction.
For example, if you have both state and county sales taxes, then create Sales Tax Items for the
state taxes and each of the county taxes. If multiple Sales Tax Items are to be billed on a
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particular sales transaction, then create a Sales Tax Group Item to join the individual Sales Tax
Items together for billing purposes. This allows QuickBooks to correctly track sales taxes by
taxing jurisdiction.

Note:
If you need to import a large number of Items (or other list entries) you can paste
in a spreadsheet using the Add/Edit Multiple List Entries option, located in the

Lists menu.
L) [ )
Printing the Item List
COMPUTER PRACTICE
To print the Item List, follow these steps:
Step 1. Select the Reports menu, select List, and then select Item Listing (see Figure 7-23).
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Bad Dedd Bad Dot - y¥rie off Cther Charge: 2.00 00  Hon
Bounce Chy Refum Chack Fee Qther Charpe L1 000 Hon
Fin Chy Financa Charges on Overdus Balence Other Charge 0% 18.0%
Shipping Shipping and handing Other Charge 000 895 HNon
Conira Cosla Contra Costa County Sales Tax Sales Tax Rem LR 825%
Cul of Stats Out-af-state ssle, exsmpt from sslea tax Sales Tax lem 1] 0% r
Sama Clara Sants Liara Counly Saes Tax Sales Tax lem (2] B25%
Santa Cruz Sants {rug Saing Tax Sales Tax lem 0.0 0%
Figure 7-23 The ttem Listing report
Step 2. Click Print at the top of the report (or select Print Report from the File menu),
Step 3. Close the Item Listing Report.
Step 4. Close the Item List window,
Other Lists

In addition to the Ifem List, there are several additional Lists in QuickBooks that you will use
when setting up customers and recording sales transactions. An understanding of how to set
up and use these Lists is essential to operating QuickBooks for your company.

The Terms List

The Terms List is where you define the payment terms for Invoices and Bills. QuickBooks uses
terms to calculate when an Invoice or Bill is due. If the terms specified on the transaction
include a discount for early payment, QuickBooks also calculates the date on which the
discount expires.

QuickBooks allows you to define two types of terms:
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e Standard Terms calculate based on how many days from the Invoice or Bill date the
payment is due or a discount is earned.

e Date-Driven Terms calculate based on the day of the month that an Invoice or Bill is due
or a discount is earned.
You can override the default terms on each sale as necessary. When you create reports for
: Accounts Receivable or Accounts Payable, QuickBooks takes into account the terms on each
| Invoice or Bill.
COMPUTER PRACTKE

Step 1. Select the Lists menu, select Customers & Vendor Profile Lists, and then select
Terms List (see Figure 7-24).

IE Terms ~§[ _Reports j i Tindude inactive §

Figure 7-24 The Terms List window

Step 2. The practice template file already includes several terms (see Figure 7-24). To set up
additional terms, select the Terms menu from the Terms List window, and then
select New, or press Ctri+N.

Step 3. To set up a standard term, complete the New Terms window as shown in Figure
7-25, and click Next.

The window in Figure 7-25 shows how the 2% 7 Net 30 terms is defined. It is a
Standard Terms Item indicating that full payment is due in 30 days. if the customers
pay within 7 days of the invoice date, however, they are eligible for a 2% discount.

Tems {%7Netso
@ Standard

Net due in [,32 J days.
Discount percentage is 3 ' 20% I

[7] Term is inactive

Discount if paid within [77' ~ |days.
"} Date Driven
Net due before the |1 lth day of the month,
Due the next month if issued within ig |days of due date.

Discount percentage is t 2.0%!

H
i

Discount if paid before the [1 _j th day of the month,

Figure 7-25 The New Terms window with standard terms
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Step 4. To set up a date-driven term, select the Date Driven radio button,
Step 5. Fill in the fields as shown in Figure 7-26. Then click OK.

The terms in Figure 7-26 are an example of Date Driven Terms, where payment is due
on the 10th of the month (e.g. February 10%). If the /nvoice is dated less than 10
days before the due date, the Invoice (or Bilf) is due on the 10th of the following
month.

s

Met duein [U“*-—jdays, o Next
Discount parcentage is [T].D% l . Term is inactive
Discount if paid within [ﬁ ]days,

@ Date Driven

Netduebeforethe 10 |th day of the month.

Due the next month ifissued within |10 |days of due date,
Discount percentageis | 0.0% .

Discount if paid before the (1 |th day of the month,

Figure 7-26 The New Terms window with date-driven terms

Step 6. Close the Term List window,
Price Levels
Note:

Per Item Price Levels are only available in QuickBooks Premier and above.

Price Levels allow you to define custom pricing for different customers. Use Price Levels on
Invoices or Sales Receipls to adjust the sales amount of particular items. There are several ways
to use Price Levels on sales forms:

DO NOT PERFORM THESE STEPS NOW. THEY ARE FOR REFERENCE ONLY.

1. You can adjust each item individually by selecting the applicable Price Level in the Rate
column drop-down list (see Figure 7-27).
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| Previous EP New' 5 Sme - G Piine v LY Send ~ B Ship i | By spiting” Ry bty | [ et - » -4 Custornize I
B us?'ﬂ_ﬁi‘*’ nhxfn(mf...] Class o Tuwlni: | Customer £
'East Bay Brding P ‘Wat C... . Academy Photo Ser.. xi, | E
| Invoice loz.r:smls l!l 2015-106 ‘ ; EdlCustomer. |
phone " sin-sssazsy
' O hualanes 242,25
Click on the drop-list arrow In the 3

Rate column to select the Price
Level right on the involice.

o TR 8T

o [ item  Quantity Desaipfion Rate | Amout | Class

] ]0utdoor Photo Session v 33 | Qutdoor Photo Session £ 2423 |Walnut NN s Tansactions

: e i Ny L AEEETR

g ‘ ol 85,50 D2/15/15 Invoice 242,25 :g
| Customer vl Tax [Contra Costa | Not-for-Profit Orgarization 80.75 :
o| Yessage Frequent Customer N 85.00 i
;- ;
| £l Tobepeiied Payment Acked - e |
| 71 To be-e-maled s Tox Cod iﬁ’;__ug Balance Due 42,25 S e e ; f
*| ) Adow ocline payment lepmmore T b
i Memao _ E

(:5!";‘0# ] Cseveatiew ] {mevent ] A

RO W P T S e e i
Figure 7-27 Selecting a Price Level on an Invoice

2. You can assign a Price Level to a Customer’s record so that when you use the
customer’s name in a sales form, QuickBooks will change the default sales price for
each Sales Item on the form (see Figure 7-28).

Customer Name [East Bay Birding ]

CurrentBalance : 0,00 1 adiust ent ?

Agressino_| Addjtional Info | _payentinke | Joblnfo |

Categorizing and Defaults Price Level  {Not-for-Profit Organization v |

Tyee . - e’ Custom Fields

From advertisement . "} + Comty L’7 T ’}

Terms — T Customer is

Net 30 v

L—E;- - T Select the Price Level for
Eﬁi T sales to this customer. This
preferred Send Method : sets the default discount for
[Noqe 7 * o ‘j f‘ sales to this customer.

Sales Tax Information ) :

TaxCode  TaxItem :

Tax v [contraCosta ¥]

Fss_aﬁwﬂ .

Figure 7-28 Setting a Price Level on a Customer’s Record

You can create new Price Levels by opening the Price Levels List and selecting New from the
Price Levels Menu or pressing Ctrl+N with the Price Levels List active. Depending on the type of
Price Level you select, QuickBooks will:

e Increase or decrease the default sales price by a fixed percentage (see Figure 7-29).
Fixed percentage Price Levels allow you to increase ot decrease prices of Items for a
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Customer or Job by a fixed percentage. For customers to whom you always give a
discount, use this optlon so that the discount will be generated automat1cally

-

@ Edit Price Level

Price Level Name  Mot-for-Profit Qrganization ] Price Level is inactive

E

Price Level Type :Fixed %% - Use this type of price level to apply a fixed percentage
' increase or decrease to all your standard sales prices when
setting up prices for different aistomers or jobs.

This price level wil Zdecrease » | item prices by l 150%1

Round up to nearest | no rounding v

How do L orint & report? K, J [ concel | bHep

Figure 7-29 Defining a new price level

* Adjust the sales price to an amount you define when setting up the Price Level. Per
Item Price Levels let you set different prices for Items that are associated with
different Customers or Jobs.

(I Edit Pnce Leve!

Price Level Name Frequenf Cusbmer - ] Price Leval is inactive

Price Level Type  Fer Item . Use this type of price lave| to set custom prices for individual items
when setting up prices for different customers or jobs,

4 ltem Cost  Standard,. CustomPrice |
Indoor Photo Session 95,00 85,00 »
Outdoor Photo Session 95,00 85.00
Photo Session 95.00
Photographer 75.00 125.00
Phatographer: Video Photographer 95.00 125.00
Retouching 95.00
Camera SR32 450.00 695.99
Case 45.00 79.99 -

[ "] mark Al
Adijust price of marked iters to be , 0.0% : %Iower } than its Estanciard price v—l rgdju_stj

Round up to nearest no raunding .

How do I print a report? [ oK. ] Lcmﬁ] ["hb ]

Figure 7-30 New Price Level window - Per Item Price Level Type
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Custom Fields

When you set up a new Customer record, you can define Custom Fields for tracking additional
information specific to your Customers, Vendors, and Employees.

Academy Photography tracks each Customer and Vendor by county in order to create reports of
total purchases and sales in a city or county. This information allows them to determine the
best area to expand business operations.

You can access the Define Fields button on the Additional Info tab of a Customer or Vendor
record (see Figure 7-31).

Customer Name | Mason, Bob
CurrentBalance :  1,177.86

: [l"_!‘d—_‘__%v‘,

H
i Click this button
, Preferred Send Method _ ; to define Custom
[None ] ! Fieids for your
f ’ E company.
Sales Tax Information

{TaxCode  TaxItem
Tax_»] [SantaClara |
? Resale Number

i
i

Figure 7-31 Click Define Fields in the Additional Info Tab.

In the window shown in Figure 7-32, you can define up to fifteen Custom Fields in the
QuickBooks data file, and any one field, i.e., Customer, Vendor, or Employee, can have up to
seven Custom Fields.

Spouse Name

Department By deflning these two
| |tite flelds and checking the
; ) boxes shown, all your
z, Review Date Vendor and Customer

records wlll have two
new flelds called County.

Figure 7-32 The Define Fields window
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Adding Custom Field Data to Customer Records

After you have defined a Custom Field and checked the box in the Customer:Job column, the
field appears on the Customer record (see Figure 7-33). Fill in the data just as you did for the
other fields.

& i oo

Customer Name  !Mason, Bob |
Current Balance :  1,177.86 How do I adiust the current balance? _

Addressinfo | AdditionalInfo | Paymentinfo | Jobinfo |

Categorizing and Defauits Price Level ST T

Type . Custom Fields

Individual ¥ County lSanta Clars

Terms SRR | o Customer is

Net 30 v K nactive
Rep .
MM - .
: L After you've

Preferred Send Method

None - defined your
Custom Fields,
Sales Tax Information they show here,
TaxCode  TaxItem ( [ Dehne feie ] §0 you can enter
Tax », [SantaClars w | T e the data for this
Resale Number customer.
- Customer

Figure 7-33 Fill in the Custom Fields for each customer.

Modifying Sales Form Templates

QuickBooks provides templates so that you can customize your sales forms. You can select
from the standard forms that QuickBooks provides, or you can customize the way your forms
appear on both the screen and the printed page. The first step in modifying your forms is to
create a template for the form you want. The templates for all forms are in the Templates List.

Note:

In addition to modifying the templates described in this section, you can also
download templates with particular designs for a fee from Intuit. To learn more
about these downloadable templates, click the Customize button on a form.

COMPUTER PRACTICE
Step 1. Select the Lists menu, and then select Templates (see Figure 7-34).

This list shows the standard templates that come with QuickBooks, as well as any
form templates the user may have created.
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.| academy Photo Service Invoice Invoice -
|Attorney's Invoice Invoice Dﬂ 4
Fixed Fee Invoice Invoice k
Intuit Packing Sp Invoice |
Intuit Product Invoice Invoice
- {Intuit Professional Invoice ; b
- s ci T e i
:}invoice from Proposal Invoice &
:[Time & Expense Invoice Invoice J
|Custom Credit Mema Credit Memo ;_‘
{Retum Receipt Credit Memo
“{Custom Sales Receipt Sales Receipt 5
| Dally Sales Summary Sales Receipt /
i| Custom Purchase Order Purchase Order .
}Intuit Standard Statement Statement i
":|Custom Estimate Estimate i
: {Proposal Estimate
|Quote Estimate . :
H - i
1:|E T@t&s v 3[ . Open Form ] {1 Indude inactive ;
Figure 7-34 The Templates list
Step 2. Select Intuit Service Invoice. Then select the Templates menu button and select

Duplicate. The Intuit Service Invoice is the template you are using as the basis for
your custom template.

Step 3. Select Invoice on the Select Template Type window and click OK (see Figure 7-35).

Select Template Type ' W

Please select the type of
template you are areating:

@ Invoice

7y Credit Memo
i) Sales Receipt
) Purchase Qrder

' Statement

P S T M

™) Estimate
™) Sales Order

T I

Fiéure 7-35 Select Terﬁpfafe .Typé window

Step 4. Copy of: Intuit Service Invoice should already be selected. Select the Templates
menu and select Edit Template.

Step 5. Click the Manage Template button in the Basic Customization window (see Figure
7-36).

Step 6. in the Manage Templates window, enter My Invoice Template in the Template Name

field (see Figure 7-37).

You must enter a unique template name. You must give your template a descriptive
name so that you will easily recognize it when selecting it from a form list.
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Basic Customization ;?: c

Selectad Tamplate __
Copy of: Intwit Service Invoice | Menage Templates...

Aot i P i s g

Logo &Fonts £ N s

Farmen Chinite
I Uselogo Seiect Loga... :

Select Color Scheme:

Change Font For:

. Change Font... il ki L

%wrww Address
%.abels

tnlﬂsbabel

Total Label

|| Compony & Transaction Information
{/| CompanyName  {Z_ Phone Mumber
7] Fax Number [T web site Address

(/] Prink Status Stamp

numwkmmumnsmsmu
e.g. PAID, PENDING, RECEIVED etr.

How do 1 200%y 3 desion across multile formg?

(L ] l_—]l_ﬁ_]l .

Frgure 7-36 Basic Customization Window

Note:
You can download templates from the Intuit website - browse through the

selection of pre-designed templates by clicking the Download Templates button
on the Manage Templates window.

Select Template Preview

|
| I
II ‘Academy Photo Service Invoice Mv[moiceTerrplaiz |
J ‘Attormey's Invoice Tempiate Hame .
‘ Fixed Fee Invoice
Intuit Packing Sip
| Intuit Product Invoice Aadws Foe marach S tem g Chgscs invoice
i
I

Inhiit Service [nveice

‘Invoice from n% —
My Invoice T¢

-Time & Expense Involoe

i I it Professiond [nvoice Priecte Y
;
i

You can change the

name of the template
In the Tamplate Name
fleld.

Totst —

[ ne ] oo ) [ ok, [ e ]

Figure 7-37 Manage Templates window

Step 7. Click OK to accept the name change and close the Manage Templates window,

Step 8. Click the Additional Customization button, The Basic Customization window
changes to the Additional Customization window.
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Step 9. Review the fields in the Header tab. Do not edit any of the fields on this window.

You would click the boxes in the Screen and Print columns to indicate which fields
will show on the screen and which fields will be printed. You could also modify the
titles for each field by changing the text in the Title fields.

Preview

sovdm Tiw o sk Crotirion e Invaice
J Header | s
= B e

L3

TAROEHIA R MRNR YR EF

Pt P,
w iih'i'ﬂ 2. .-'a,;.,z_t] [»; ;-:z,m‘é!ﬁ.xmr,-mi

Figure 7-38 Additional Customization window showing the Header tab

Step 10. Click the Columns tab to modify how the columns display on the Invoice. Change
the order of the columns by entering the numbers in the Order column as shown in
Figure 7-39. If you see the Layout Designer warning box, ciick OK.

Soeen Print Ocder  Tite
fo}
I IR
wm iz,
M 3]
i @ [ ]
o g [b]
[ T

Figure 7-39 Additional Customization window showing the Columns tab

Step 11. Click the OK button to return to the Basic Customization window.
Step 12. Next, add a logo to the template by checking the Use logo checkbox (see Figure
7-40).
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Adding a business logo to an /nvoice helps customers familiarize themselves with
_ yaur company. It can also help them identify your /nvoice.
| PR Citomiion =7 O R S e

i Selected Template
: My Invoice Template

Lego & Fonts

[ Use Jogo (__/——" © ¢/l Placing a check In the Use togo

checkbox opens a Browse window

Figure 7-40 The Use logo option in the Basic Customization window

Step 13. In the Select Image dialog box, navigate to your student files. Select logo.gif and
click Open.
Step 14. A dialog box warns that the logo graphic file will be copied to a subfolder of the

location of your working file. Click OK to accept. You should see the logo in the
upper left side of the preview pane of the Managing Templates window.

Step 15. Click the Select Color Scheme drop down menu. You can choose six preset colors.
Choose Maroon and then click the Apply Color Scheme button. The text and
border lines on the Invoice change to the selected color.

Step 16. Next, change the color of the invoice title to black. Verify that Title is selected in the
Change Font for: box and click the Change Font button.

Step 17, The Example window opens (Figure 7-41). You can use this window to change font,
size, style, and color of the title of the invoice. In the Color field, choose Black. When
finished, click OK.

Example
1 Eont: Font Style: Size:
rial * Bold 2

A .| (2 .

e |

" —| |Bold Itali - |9 )
| |Arial Rounded MTL B;:alcitallc L e 1=
:| [Baskerville Old Face - | |Black Oblique ~| |11~
| elp
il Effects Sample
Shikeout
| Dunderive AaBbYyZz
G
’ I Black - This is an OpenType font. This same fort will be

used on bath your printer and your screen.

2
i J

Figﬁr-e 741 E-xample diafo_(‘j' box for changmg font of labefs on a femp!ate

Step 18. Click OK to close the Basic Customization window.

Step 19. Close the Templates window.

Step 20. From the Home Page, click the Create Invoices icon.

Step 21, To use the new template, choose My Invoice Template from the Template drop
down list,
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Step 22, To view how the Invaice will print, click the down arrow next to Print button at the
top of the Create Invoices window and select Preview.
Step 23. Click Close to close the Print Preview window.
Step 24. Close the Create Invoices window.
Note: . ' PO SO S S L R Fr i i A2 B B SO AR

You can make further changes to the position of él_émgiltiht‘gi{n__t,l_le:fbp}} by, ..
opening the Layout Designer. Click the Layout Designer. button on the bottom
of the Basic Custornization window. From the Layout Designer, you can ‘change -
the position of design élements, such as thie textboxes and the logo.’ T

Review Questions

Select the best answer(s) for each of the following:

1. You can create Custom Fields for:

a)  Customers.

b)  Templates.

©) Vendors.

d) Bothaandc.

2. The two types of Preferences are:

a)  User and Company Preferences.

b)  User and Accountant Preferences.
c)  Favorite and General Preferences.
d) Income and Expense Preferences.

3. If you don't see the Favorites menu in your menu bar, you can turn it on in the:

a)  Customize Templates window.
b) Customize Icon Bar window.
c) View menu.

d) Windows menu.

4, Which of the following is not an available Template type in QuickBooks?

a) Credit Memo.
b)  Statement.

c) Check.

d)  Sales Receipt.

5. If you pay sales tax to more than one agency, you should use which of the following
Itemn types?

a)  Sales Tax Group.

b)  Group.

¢)  Inventory Assembly.
d)  Subtotal.
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Customizing - Problem 1

APPLYING YOUR KNOWLEDGE

| Restore the Customizing-12Problem1.QBM file. —|

1. Set up the following Terms:

a) 3% 7 Net 30

b) 3% 10™ Net 20'"" (Due next month if issued within 10 days of the due date)
<) Net 45

d)  3%7" Net 30" (Due next month if issued within 10 days of the due date)

J

1 2. Create a Terms Listing report (Select the Reports menu, Lists, and then Terms Listing).
! Add the Discount on Day of Month and Min Days to Pay columns, Expand the

‘1 columns so you can see the entire column headers. Print the report.

1 3. Add a Custom Field to your Customers called Web Site. Add the web sites to the following
i customer records:

1 Customner:Job Name Web Site
J Anderson Wedding Planners: Kumar, www.andweddingbliss.net
{ sati and Naveen
¥ Anderson Wedding Planners; Wilson, www.andweddingbliss.net |
Sarah and Michael |
Anderson Wedding Planners www.andweddingbliss.net R
Pelligrini, George www.pelligrinibuild.net
J Pelligrini, George:2354 Wilkes Rd www.pelligrinibuild.net
A Pelligrini, George: 4266 Lake Drive www.pelligrinibuild.net

Table 7-1 Web site data for custom fields

only.

3. Create a Sales Tax Item for Santa Cruz, payable to the State Board of Equalization. The

|
: | ' 4. Create a Customer Contact List, modified to display the Customer Name and Web Site
. sales tax rate is 8.25%.

}

6. Create a duplicate Invoice of the Intuit Service Invoice Template. Then, make the
following changes:

. @)  Change the name of the template to Academy Photo Invoice.

b)  Add the Web Site custom field to the screen and printed Invoice using the
Additional Customization Header tab.

¢)  When prompted, click Default Layout.

7. Create a new Non-inventory Part called Custom Package. Set up the new Item using the
following information:

Customizing QuickBooks — Review Questions




Customizing QuickBooks — Review Questions 231

g Field Name Data
‘; Item Name/Number Custom Package
§ Description Customized Photography Package from

Session

0 (leave O because it’s a custom package)
Tax

¥ Account Sales

Table 7-2 item setup data

8. Create an Invoice for Pelligrini, George, for the 1254 Wilkes Rd job, using the Academy
Photo Invoice template. Enter the following information on the header of the Invoice:

g Field Name Data

Y Class San Jose
f Date 02/28/2015
# Invoice # 2015-106

f Terms 3% 7 Net 30
f# Tax Santa Cruz

Table 7-3 Use this data for the Invoice header.

9. Enter the following information into the body of the Invoice:

Item Description Amount

Outdoor

Photo Qutdoor Photo 190.00
. Session

Session

Customized
Custom Photography
Package Package from
Session

1500.00

Table 7-4 Item descriptions

10. Accept the default for all other fields on the Invoice. Click OK if you get a pop-up
window regarding custom price levels. Save and print the Invoice.

11. Save the new Terms and Tax Items when prompted.
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